Contact Mode	�



Contact Mode provides a rich set of contact management features. Contact Mode lets you add contacts, schedule follow-up tasks, record conversations, define company and contact groups, print labels, export mail merge files to word-processors and a whole lot more.



Contact Mode contains several different views on your contact data. These views are:



			�SYMBOL 183 \f "Symbol" \s 12 \h�	Company View

			�SYMBOL 183 \f "Symbol" \s 12 \h�	Contact View

			�SYMBOL 183 \f "Symbol" \s 12 \h�	Directory View

			�SYMBOL 183 \f "Symbol" \s 12 \h�	Conversation View



Company View shows company information, namely the site address and a list of employees (contacts) who work for the company. Contact View shows information specific to a particular contact, for example, the name and address of the company to which the contact belongs, if any, and the contact's home address, title, position etc. 



The Directory View shows both company and contact information in a telephone directory format. 



Conversation View show conversations that you and other users have documented with contacts.



Company View� XE "Company View" �    �



When you enter Contact Mode initially, the Company View will be displayed. 



�



The Company View





A� XE "Adding a Company Record" �dding a Company Record



One way of adding a company record is as follows:



Œ Press the � button above the Company Window. A Company dialog box� XE "Company dialog box" � will appear.



�	Fill in the fields with the relevant information.



Ž	Press OK.



�



Company dialog box



There are several other ways to add a company record. All the possible ways to add a company record are shown in the table below:



Action�Description��Using the � button. �Press the � button. This brings up the Company dialog box. Enter the relevant details and press OK.��Using the � button.�Press the � button in the sub toolbar. This brings up the Company dialog box. Enter the relevant details and press OK.��Using the menu.�Select New Company from the Edit/Company menu. This brings up the Company dialog box. Enter the relevant details and press OK.��Pressing the INSERT key on the keyboard.�Pressing the INSERT key brings up the Company dialog box. Enter the relevant details and press OK.��Double clicking.�Provided that there is no record shown in the Company Window, double click using the left mouse button in the Company Window. This brings up the Company dialog box. Enter the relevant details and press OK.��



A� XE "Adding Duplicate Records" �dding Duplicate Records� XE "Duplicate Records" �



If you add a company record whose name already exists, OfficeTalk detects this and pops up a Company Exists dialog box.



�



Company Exists dialog box



OfficeTalk gives you three choices of what to do. 



If you wish to add the record as a separate record, keeping the same company name but in no way relating it to the record already existing with that name then press the � button.



If you wish to add the record, making it another address of the record already existing with that name then press the � button. The record will be added and the text “more...” will be shown at the bottom right of the Company Window when this record is displayed. Pressing the left mouse button while the cursor is over the “more...” text will cause OfficeTalk to display the next record in that group of sites.



If you wish to cancel the operation such that the record is not added at all, then press the � button.



M� XE "Moving Around the Database" �oving Around the Database



The company records are stored in alphabetical order. You can view the previous or next record in the database by pressing the �� XE "Previous Contact Button" � or �� XE "Next Contact Button" � buttons. Alternatively, you can use the LEFT or RIGHT keys on the keyboard to move to the previous or next record. Pressing the HOME key on the keyboard will take you to the first company record in the database and pressing the END key will take you to the last record. You can use the Alphabetical Index at the top of the Company Window to show the first record beginning with the letter that you select. For example, to move directly to the first record beginning with the letter T, press the T tab in the Alphabetical Index. If there are no records beginning with T, OfficeTalk will display the next record alphabetically. 



�EMBED PBrush \s  \* mergeformat���



The Alphabetical Index



E� XE "Editing a Company Record" �diting a Company Record



One way of editing a company record is as follows:



Œ Select the record that you wish to edit.



�	Press the � window button. The Company dialog box will appear with the details of the selected company filled out.



Ž	Modify the data as required and press OK.



There are several other ways to edit a company record. All the possible ways to edit a company record are shown in the table below:



Action�Description��Using the � button.�Select the company that you wish to edit and press the � button. The Company dialog box will appear. Modify the data as required and press OK.��Double clicking.�Select the company that you wish to edit and double click on the Company Window. The Company dialog box will appear. Modify the data as required and press OK.��Using the Menu.�Select the company that you wish to edit and then select Edit Company from Edit/Company menu. The Company dialog box will appear. Modify the data as required and press OK.��Pressing the ENTER key on the keyboard.�Select the company that you wish to edit and press the ENTER key on the keyboard. The Company dialog box will appear. Modify the data as required and press OK.��



Deleting a Company Record� XE "Deleting a Company Record" �



One way of deleting a company record is as follows:



Œ Select the company that you wish to delete.



�	Press the � button above the Company Window. 



Ž	OfficeTalk will confirm that you wish to delete the company. Press Yes to delete the company.



�



Confirmation of deletion



There are several other ways to delete a company record. All the possible ways to delete a company record are shown in the table below:



Action�Description��Using the � button.�Select the company that you wish to delete and press the � window button.��Using the menu.�Select the company that you wish to delete and select Delete Company from the Edit/Company menu.��Press the DELETE Key on the keyboard.�Select the company that you wish to delete and press the DELETE key on the keyboard.��



S� XE "Searching for a Company Record" �earching for a Company Record



You can search for a particular company or companies by pressing the �EMBED PBrush \s  \* mergeformat��� button. This will bring up the Search Companies dialog box.



�



Search Companies dialog box



The Search Companies dialog box consists of several fields into which you may enter your search text, two radio buttons for specifying whether you wish to search for a sequence beginning with or containing the search text, a � button for performing the search and a � button for displaying the resulting record(s). The most common search is a company name search. You can search for a company by name in the following way:



Œ Enter the first few letters of the company name into the Company Name field.



�	Ensure that all other fields are blank. Ensure that the Begins With radio button is selected.



Ž Press the � button.



OfficeTalk will very quickly find the company or companies whose name begins with the letter(s) that you entered into the Company Name field. The results of the search will appear in the Results window at the bottom of the Search Companies dialog box. You can display any of the companies in the Results window by selecting the relevant company and pressing the � button. OfficeTalk will close the dialog box and display the record in the Company Window.



You can search any of the other fields in exactly the same way. However, if you search other fields and the Company Name field is empty, the search will take a little longer.



The searching method described above requires you to enter the first few letters of a particular field in a company record. OfficeTalk also lets you perform a search on records containing a specified search text.



For example, if you knew that the company that you wished to find had two consecutive letter O's in its name, then you could enter the characters: oo into the Company Name field and select the Containing radio button and then perform the search. 



You may enter search text into more than one field when searching for a particular company. For example, entering the letter A into the Company Name field and the word Seattle into the Town/City field will find all those companies beginning with the letter A who are based in Seattle.



P� XE "Personal Company Records" �ersonal Company Records



Sometimes, you will want to mark certain company records as personal to you. You can do this in the following way:



Œ Select the company that you wish to make personal to yourself.



�	Press the � button. The Company dialog box will appear.



Ž Select the Personal Record radio button.



� Press OK.



Company records which are personal to yourself may only be seen by you and will only be found in any searches performed by you. Personal records in Contact Mode are displayed with a � symbol to distinguish them from public records.



A� XE "Attaching Notes to a Company" �ttaching Notes to a Company



OfficeTalk lets you write notes about any company and keep them with the company record. You can do this in the following way:



Œ Select the company that you wish to write notes for.



�	Press the �EMBED PBrush \s  \* mergeformat��� button. The Company Notes dialog box will appear.



Ž Enter any free format text and press OK.



Another way to add notes to a company is by pressing the � button in the Company dialog box.



When you add notes to a company, a � marker will appear next to the Comment field to indicate that this company has some notes attached. You can quickly pop up the Company Notes dialog box by double clicking on the � marker, using the left mouse button.



You can delete the notes for a company by selecting Delete Notes from the Edit/Company menu. The � marker will then disappear.





A� XE "Adding Contacts to a Company" �dding Contacts to a Company



The window at the bottom of the Company View is called the Contacts Window. It is a list of contacts which are associated with the company currently displayed. It is possible to add a contact from either the Company View or the Contact View (see Contact View section). If you add the contact from the Company View, the contact will automatically be associated with the displayed company. You can add a contact and associate it with the displayed company in the following way:



Œ Select the company to which you wish to add the contact.



�	Double click in a blank part of the Contacts Window at the bottom of the Company View using the left mouse button or press the � button. A Contact dialog box will appear.



Ž Enter the details of the contact and press OK. 



The contact will appear in the Contacts Window at the bottom of the Company View. It is possible to change the company with which a contact is associated. For more information on this, see � REF _Ref314626828 \* MERGEFORMAT �S� XE "Specifying the Company to which a Contact Belongs" �pecifying the Company to which a Contact Belongs� in the Contact View section.



A� XE "Auto Dialling a Company" �uto Dialling a Company



You may auto dial a company provided:



�SYMBOL 183 \f "Symbol" \s 12 \h�	You have a modem connected directly to your computer using the same phone line as your handset phone.



�SYMBOL 183 \f "Symbol" \s 12 \h�	The company phone number details have been entered.



You can auto dial a company by pressing the � window button above the Company Window. Pressing this button will bring up the Dial Company dialog box. 



�



Dial Company dialog box



You may choose which of the two company phone numbers to dial by selecting either the Phone1 or Phone2 radio buttons. Alternatively, you may enter a telephone number directly into the Number field. When you press OK, OfficeTalk will initialise the modem and dial the selected number.



You should ensure that the modem is correctly setup. You can do this by selecting Modem Settings from the Options menu. For more information on modems, see Setting up a Modem for OfficeTalk later in this chapter.



�A� XE "Adding other Addresses for a Company" �dding other Addresses for a Company



OfficeTalk lets you store an unlimited number of additional sites for a particular company. You can do this in the following way:



Œ Select the company to which you wish to add an additional site (address).



�	Press the � button. The Company dialog box will appear. Press the � button. An Addresses dialog box will appear. This dialog box contains a list of other site addresses associated with this company. Each address is, in fact, a separate record. OfficeTalk does not let you delete addresses from this dialog box, however you may add new addresses or edit existing ones.



�



Addresses dialog box



Ž Press the � button. This will bring up an Address dialog box. Enter the address of the additional site and press OK. 



�



Address dialog box



If you wish to add an existing company record as another site of a particular company then OfficeTalk lets you do this in the following way:



Œ Select the company which you wish to add as an additional site (address).



� Select Make Other Address from the company menu (under the Edit menu)



Ž OfficeTalk will pop up a Search dialog box. Use the dialog box to search for the company that you wish to group the original company with. Select the company from the dialog box by selecting the company from the Results window and pressing the � button. OfficeTalk will confirm that you wish to add the displayed company as another site of the selected company. Press �.



�



OfficeTalk Confirmation



In both the above cases, the companies will be linked together and the text “more...” will appear at the bottom right of the Company Window on both records. Pressing the left mouse button while the cursor is over the text will cause OfficeTalk to display the next record in that group of sites.



If you wish to remove a company record from a group of sites then you can do this in the following way:



Œ Select the company which you wish to remove from the group of sites.



� Select Make Separate Address from the Company menu (under the Edit menu). OfficeTalk will confirm that you wish to remove the selected company from the group of sites. Press �.



�



OfficeTalk Confirmation





L� XE "Linking a Company to other OfficeTALK data" �inking a Company to other OfficeTalk data



OfficeTalk lets you link companies to other OfficeTalk data. You can do this in the following way:



Œ Select the company that you wish to link so that it is displayed in the Company Window.



	� Press the � button above the Company window.



Ž Select another linkable item and press the � button above that item’s window.



The company will now be linked to that item. A �EMBED PBrush \s  \* mergeformat��� symbol will appear in the Company Window. For more information on linking, see the Linking section in the chapter named General OfficeTalk Features.





S� XE "Selecting a Company/Contact Group" �electing a Company/Contact Group



OfficeTalk lets you create groups of companies or contacts. For more information on creating, editing or deleting company/contact groups, see Creating a Company/Contact Group later in this section.



When you select a company/contact group, only the companies or contacts in this group will be visible from the Company, Contact and Directory Views. You may select a company/contact group in the following way:



Œ Press the � window button. A Select Contact Group dialog box will appear.

� Select the required group from the Contact Group pull down list.

	Ž Press OK.



�



Select Contact Group dialog box



The group name will be displayed above the Company and Contact Windows as well as the number of records available. Searching and printing will work with the currently selected group. You can deselect the currently selected group by selecting --No Group-- from the Contact Group pull down list in the Select Contact Group dialog box.



�A� XE "Adding a Company to a Group" �dding a Company to a Group



You may add a company to a company/contact group in the following way:



Œ Select the company that you wish to add to the group by viewing it in the Company Window.



� Press the �EMBED PBrush \s  \* mergeformat��� button. A Select Contact Group dialog box will appear.



Ž Select the required group from the Contact Group pull down list.



� Select any contacts, belonging to the company, that you wish to add to the group in addition to adding the company itself.



( Press OK. OfficeTalk will verify that you wish to add the current company to the selected group. Press Yes to confirm.



�



Select Contact Group dialog box





F� XE "Finding Which Groups a Company Belongs to" �inding Which Groups a Company Belongs to



OfficeTalk lets you view which groups a particular company belongs to. You can do this by selecting the company into the Company Window and pressing the � button. If the selected company does not belong to any groups then a dialog box will appear indicating this to you.



�



OfficeTalk Message



If the company does belong to one or more groups then pressing the � button will pop up a window listing all the groups to which the company belongs:



�



Groups to which the selected company belongs





P� XE "Printing Companies" �rinting Companies



OfficeTalk lets you print out companies by pressing the � button above the Company Window. When you press this button, the Print Companies dialog box will appear.



�



Print Companies dialog box



The fields and buttons in the Print Companies dialog box are described in the table below:



Field/Button�Description��All companies/

Current group/

Current company�You may choose what to print by selecting one of these radio buttons. You can print either all companies in the entire database, or, if there is a group currently selected, you can print that group or you can print the current company.��Draw line between records�Check this check box if you wish to print a horizontal line between each record printed.��New page per alphabetical section�Check this check box if you wish to start a new page for every new alphabetical section.��One record per page�Check this check box if you wish to print only one company record per page.��Print Fields�Select which fields you wish to print from this array of check boxes.��Address Indent�This is the amount of indent between the company name and the other fields printed below. The default is 0 inches.��Paper�This is the paper style that OfficeTalk will use to print. For more information on paper styles, see the Printing section in the General OfficeTalk Features chapter.��Title Font�The font of the company name.��Field Font�The font of the company address.��

OfficeTalk provides common print functionality in all Print dialog boxes. This functionality includes:



	�SYMBOL 183 \f "Symbol" \s 12 \h�  Defining headers and footers

	�SYMBOL 183 \f "Symbol" \s 12 \h�  Printer setup

	�SYMBOL 183 \f "Symbol" \s 12 \h�  Preview capability



For more information on this common print functionality, see the Printing section in the General OfficeTalk Features chapter.



If you preview the companies print out, with careful selection of fonts, OfficeTalk will display a preview output similar to that shown below:



�



Company print preview





I� XE "Importing Companies from a CSV file" �mporting Companies from a CSV file



OfficeTalk lets you import company records from Comma Separated Values (.CSV) files. A typical CSV file format is shown in the table below:



"Name",�"Address1",�"Address2",�"Town",�"Postcode"��"Softalk Ltd",�"1 May Sq",�"Hurley St",�"Aylesford",�"HP17 7DD"��"DSA",�"Bydell Hse"�"Sudbry Hill",�"Harrow",�"HA1 3NJ"��"Acme Ltd",�"Acme Rd",�"Acme Hill",�"London",�"SE1"��"Intera Ltd",�"Chiltern Hs",�"45 Stn Road",�"Henley",�"RG9 1AT"��"PPG",�"1 Pit Way",�"Murray Rd",�"Staines",�"ST1 1DR"��

CSV File Format



The first line in a CSV file is called the header line and this must always be present. The header defines the field names of the CSV file. The following lines are individual company records. Most database packages will provide a CSV format output of their data. Once you have a file in this format, you may import the data into OfficeTalk in the following way:



Firstly, select Import CSV Records from the File menu within Contact mode.



�



The Import CSV Records Command



A CSV Import dialog box will appear:



�



CSV Import dialog box



Œ	Select the CSV file containing the data that you wish to import. You can do this by pressing the � button and selecting the file from the File dialog box.

�	Ensure that Company is selected in the Import Type pull down list. Note that if you wish all the imported companies to be visible only to you then select Personal Company from the Import Type pull down list.

Ž	The OfficeTalk Fields list will contain the available fields in a company record. The Available Fields list will contain a list of fields found in the CSV file. You can connect the CSV file fields to OfficeTalk fields by selecting an item from each list and pressing the � button. The connection will appear in the Connections list at the bottom of the dialog box. 

�	If the CSV file has quoted fields (every field is enclosed by a pair of “” characters) then ensure that the Quoted Fields check box is checked. Sometimes fields are separated by TAB characters instead of commas. If this is true ensure that Tab is selected from the Delimiter pull down list.

(	Press the � button. OfficeTalk will begin importing the records. A Percentage window will appear informing you of the progress of the import. You can cancel the import at any time by pressing the Cancel button on the percentage window.



If a company/contact group is currently selected, then the Import into current group check box will be enabled. If you check this box, OfficeTalk will import the data and will automatically put each record into the currently selected group.



Note: Importing companies does just that, it does not import contact information. If you have a CSV file containing both company and contact information then you must firstly import the companies and then import the contacts using the same CSV file. For detail on how to do this, see Connecting Contacts to Companies via a CSV later in this chapter.



D� XE "Duplicate Checking on CSV Input" �uplicate Checking on CSV Input



When OfficeTalk imports companies, a check is performed every time a record is about to be added to ensure that a similar company record does not already exist. For example, if a company Softalk, for instance, is about to be imported from the CSV file, OfficeTalk will check to ensure that the company record for Softalk does not already exist. If it does, OfficeTalk will not add the new record, but will instead store the record in a list which it will present at the end of the CSV import. The list will appear in a window as shown below:



�



Repeated Companies dialog box

�

E� XE "Exporting Companies to a CSV file" �xporting Companies to a CSV file



OfficeTalk lets you export company records to a CSV file. You can do this in the following way:



Œ	Select Company CSV Records from the File/Export menu in Contact Mode. A CSV Output dialog box will appear.



�



CSV Output dialog box



�	Select a filename for the output CSV file. You can do this by pressing the � button and selecting the filename from the Save As dialog box.

	

Ž	If you want each item of data to be encapsulated by quotes, then ensure that the Quoted Fields check box is select. If you want to output a header record at the top of the file then check the Output Header check box. If you want to end each record line with a delimiter (the default is not to) then check the End line with delimiter check box.



�	Choose a delimiter (field separator) by choosing a delimiter from the Delimiter field. You can choose between a TAB character and a COMMA.



(	Press OK. OfficeTalk will then export the records in the selected group (or all records in the database if no group is selected) to the specified CSV file.

�Contact View    �� XE "Contact View" �



The Contact View is shown below:



�



Contact View



Adding a Contact Record� XE "Adding a Contact Record" �



One way of adding a contact record is as follows:



Œ Press the � button above the Contact Window. A Contact dialog box will appear.



�	Fill in the fields with the relevant information



Ž	Press OK.

�



Contact dialog box



There are several other ways to add a contact record. All the possible ways to add a contact record are shown in the table below:



Action�Description��Using the � button.�Press the � button. This brings up the Contact dialog box. Enter the relevant details and press OK.��Using the � button.�Press the � button. This brings up the Contact dialog box. Enter the relevant details and press OK.��Using the menu.�Select New Contact from the Edit/Contact menu. This brings up the Contact dialog box. Enter the relevant details and press OK.��Pressing the INSERT key on the keyboard.�Pressing the INSERT key brings up the Contact dialog box. Enter the relevant details and press OK.��Double clicking.�Provided that there is no record shown in the Contact Window, double click using the left mouse button in the Contact Window. This brings up the Contact dialog box. Enter the relevant details and press OK.��M� XE "Moving Around the Database" �oving Around the Database



The contact records are stored in alphabetical order. You can view the previous or next record in the database by pressing the � or � buttons. Alternatively, you can use the LEFT or RIGHT keys on the keyboard to move to the previous or next record. Pressing the HOME key on the keyboard will take you to the first contact record in the database and pressing the END key will take you to the last record. You can use the Alphabetical Index at the top of the Contact Window to show the first record beginning with the letter that you select. For example, to move directly to the first record beginning with the letter T, press the T tab in the Alphabetical Index. If there are no records beginning with T, OfficeTalk will display the next record alphabetically. 



�EMBED PBrush \s  \* mergeformat���



The Alphabetical Index



E� XE "Editing a Contact Record" �diting a Contact Record



One way of editing a contact record is as follows:



Œ	Select the record that you wish to edit.



�	Press the � button. The Contact dialog box will appear with the details of the selected contact filled out.



Ž	Modify the data as required and press OK.



There are several other ways to edit a contact record. All the possible ways to edit a contact record are shown in the table below:



Action�Description��Using the � button.�Select the contact that you wish to edit and press the � button. The Contact dialog box will appear. Modify the data as required and press OK.��Double clicking.�Select the contact that you wish to edit and double click on the Contact Window. The Contact dialog box will appear. Modify the data as required and press OK.��Using the menu.�Select the contact that you wish to edit and then select Edit Contact from Edit/Contact menu. The Contact dialog box will appear. Modify the data as required and press OK.��Pressing the ENTER key on the keyboard.�Select the contact that you wish to edit and press the ENTER key on the keyboard. The Contact dialog will appear. Modify the data as required and press OK.��

D� XE "Deleting a Contact Record" �eleting a Contact Record



One way of deleting a contact record is as follows:



Œ	Select the contact that you wish to delete.



�	Press the � button above the Contact Window. 



OfficeTalk will confirm that you wish to delete the contact.



�



OfficeTalk confirmation



There are several other ways to delete a contact record. All the possible ways to delete a contact record are shown in the table below:



Action�Description��Using the � button.�Select the contact that you wish to delete and press the � button.��Using the menu.�Select the contact that you wish to delete and select Delete Contact from the Edit/Contact menu.��Press the DELETE Key on the keyboard.�Select the contact that you wish to delete and press the DELETE key on the keyboard.��

S� XE "Searching for a Contact Record" �earching for a Contact Record



You can search for a particular contact or contacts by pressing the �EMBED PBrush \s  \* mergeformat��� button above the Contact Window. This will bring up the Search Contacts dialog box.



�



Search Contacts dialog box



The Search Contacts dialog box consists of several fields into which you may enter your search text, two radio buttons for specifying whether you wish to search for a sequence beginning with or containing the search text, a � button for performing the search and a � button for displaying the resulting record(s). The most common search is a last name search. You can search for a contact by name in the following way:



Œ Enter the first few letters of the contact name into the Last Name field.



�	Ensure that all other fields are blank. 



Ž Press the � button.



OfficeTalk will very quickly find the contact or contacts whose name begins with the letter(s) that you entered into the Last Name field. The results of the search will appear in the Results window at the bottom of the Search Contacts dialog box. You can display any of the contacts in the Results window by selecting the relevant contact and pressing the Goto button. OfficeTalk will close the dialog box and load the record into the Contact Window.



You can search any of the other fields in exactly the same way. However, if the Last Name field is empty, the search will take a little longer.



The searching method described above requires you to enter the first few letters of a particular field in a contact record. OfficeTalk also lets you perform a search on records containing a specified search text.



For example, if you knew that the contact that you wished to find had two consecutive letter O's in the last name, then you could enter the characters: oo into the Last Name field, select the Contains radio button and then perform the search.



You may enter search text into more than one field when searching for a particular contact. For example, entering the letter A into the Last Name field and the word Seattle into the Town/City field will find all those contacts whose last name begins with the letter A and are from Seattle.





M� XE "Making a Personal Contact Record" �aking a Personal Contact Record



Sometimes, you will want to mark certain contact records as personal to you. You can do this in the following way:



Œ Select the contact that you wish to make personal to yourself.



�	Press the � button. The Contact dialog box will appear.



Ž Select the Personal Record radio button.



� Press OK.



Contact records which are personal to yourself may only be seen by you and will only be found in any searches performed by you. Personal records in Contact Mode are displayed with a � symbol to distinguish them from public records. You may not make a contact into a personal contact if he/she belongs to a company which is public.





A� XE "Attaching Notes to a Contact" �ttaching Notes to a Contact



OfficeTalk lets you write notes about any contact and keep them with the contact record. You can do this in the following way:



Œ Select the contact that you wish to write notes for.



�	Press the �EMBED PBrush \s  \* mergeformat��� button. The Contact Notes dialog box will appear.



Ž Enter any free format text and press OK.



Another way to add notes to a contact is by pressing the � button in the Contact dialog box.



When you add notes to a contact , a � marker will appear next to the Comment field to indicate that this contact has some notes attached. You can quickly pop up the Contact Notes dialog box by double clicking on the � marker, using the left mouse button.



You can delete the notes for a contact by selecting Delete Notes from the Edit menu. The � marker will then disappear.





S� XE "Specifying the Company to which a Contact Belongs" �pecifying the Company to which a Contact Belongs



OfficeTalk lets you specify which company, if any, a particular contact belongs to. You can do this in the following way:



Œ 	Select the relevant contact so that it is showing in the Contact Window



�	Press the � button. The Contact dialog box will appear.



Ž 	Press the � button next to the Employee of field. A Search Companies dialog box will appear.



� 	Type the first few letters of the required company and press the � button. The company should appear in the Results list. Select the company from the Results list. If you do not want the contact to be associated with any company then select --No Company--. Press the � button. Finally, press OK on the Contact dialog box.



�



Search Companies dialog box





A� XE "Auto Dialling a Contact" �uto Dialling a Contact



You may auto dial a contact provided:



�SYMBOL 183 \f "Symbol" \s 12 \h�	You have a modem connected directly to your computer using the same phone line as your handset phone.



�SYMBOL 183 \f "Symbol" \s 12 \h�	The contact phone number details have been entered.



You can auto dial a contact by pressing the � button above the Contact Window. Pressing this button will bring up the Dial Contact dialog box. 



�



Dial Contact dialog box



You may choose which of the four contact phone numbers to dial by selecting one of the Company phone1, Company phone2, Home1, or Home2 radio buttons. Alternatively, you may enter a telephone number directly into the Number field. When you press OK, OfficeTalk will initialise the modem and dial the selected number.



You should ensure that the modem is correctly setup. You can do this by selecting Modem Settings from the Options menu. For more information on modems, see � REF _Ref314631828 \* MERGEFORMAT �S� XE "Setting Up A Modem For OfficeTALK" �etting Up A Modem For OfficeTalk� later in this chapter.





L� XE "Linking a Contact to other OfficeTALK data" �inking a Contact to other OfficeTalk data



OfficeTalk lets you link contacts to other OfficeTalk data. You can do this in the following way:



Œ Select the contact that you wish to link so that it is displayed in the Contact Window.

� Press the � button above the Contact Window.

Ž Select another linkable item and press the � button above that item’s window.



The contact will now be linked to that item. A �EMBED PBrush \s  \* mergeformat��� symbol will appear in the Contact Window. For more information on linking, see the Linking section in the chapter named General OfficeTalk Features.





M� XE "Mailing Contacts" �ailing Contacts



OfficeTalk lets you specify an EMail address for contacts so that they may be mailed from within Mail Mode. You can specify an EMail address for a contact in the following way:



Œ 	Select the contact that you wish to give an EMail address by viewing it in the Contact Window.



� 	Press the � button. The Contact dialog box will appear. Select the mail system through which you wish to mail the contact (i.e. MAPI or VIM). Specify the EMail address in the Email field. Press OK.



The contact may now be addressed via the Send To Window from within Mail Mode. For more information on mailing contacts see Using a Contact Mail Address in the Mail Mode chapter.



A� XE "Contact Groups" �� XE "Adding a Contact to a Group" �dding a Contact to a Group



You may add a contact to a company /contact group in the following way:



Œ Select the contact that you wish to add to the group by viewing it in the Contact Window.

� Press the �EMBED PBrush \s  \* mergeformat��� button. A Select Contact Group dialog box will appear.

Ž Select the required group from the Contact Group pull down list.



�



Select Contact Group dialog box



� Press OK. OfficeTalk will verify that you wish to add the current contact to the selected group. Press Yes to confirm.



�



OfficeTalk Confirmation

F� XE "Contact Groups" �� XE "Finding Which Groups a Contact Belongs to" �inding Which Groups a Contact Belongs to



OfficeTalk lets you view which groups a particular contact belongs to. You can do this by selecting the contact into the Contact Window and pressing the � button. If the selected contact does not belong to any groups then a message box will appear indicating this to you.



�



OfficeTalk message



If the contact does belong to one or more groups then pressing the � button will pop up a window listing all the groups to which the contact belongs:



�



Groups to which the selected contact belongs





P� XE "Printing Contacts" �rinting Contacts



OfficeTalk lets you print out contacts by pressing the � button above the Contact Window. When you press this button, the Print Contacts dialog box will appear.



�



Print Contacts dialog box



The fields and buttons in the Print Contacts dialog are described in the table below:



Field/Button�Description��All companies/

Current group/

Current contact�You may choose what to print by selecting one of these radio buttons. You can print either all contacts in the entire database, or, if there is a group currently selected, you can print that group or you can print the current contact.��Draw line between records�Check this check box if you wish to print a horizontal line between each record printed.��New page per alphabetical section�Check this check box if you wish to start a new page for every new alphabetical section.��One record per page�Check this check box if you wish to print only one contact record per page.��Print Fields�Select which fields you wish to print from this array of check boxes. If you select the Print "Company Address" or Print "Contact Address" check box, OfficeTalk will print Company Address or Contact Address above the relevant address.��Address Indent�This is the amount of indent between the contact name and the other fields printed below. The default is 0 inches.��Paper�This is the paper style that OfficeTalk will use to print. For more information on paper styles, see the Printing section in the General OfficeTalk Features chapter.��Title Font�The font of the contact name.��Field Font�The font of the contact address.��

OfficeTalk provides common print functionality in all Print dialog boxes. This functionality includes:



	�SYMBOL 183 \f "Symbol" \s 12 \h�  Defining headers and footers

	�SYMBOL 183 \f "Symbol" \s 12 \h�  Printer setup

	�SYMBOL 183 \f "Symbol" \s 12 \h�  Preview capability



For more information on this common print functionality, see the Printing section in the General OfficeTalk Features chapter.



If you preview the contact print out, with careful selection of fonts, OfficeTalk will display a preview output similar to that shown below:



�



Contact print preview



I� XE "Importing Contacts from a CSV file" �mporting Contacts from a CSV file



OfficeTalk lets you import contact records from Comma Separated Variable (.CSV) files. A typical CSV file format is shown in the table below:



"Company",�"Surname"�"Address1",�"Address2",�"Town",��"Softalk Ltd",�"Bates"�"1 May Sq",�"Hurley St",�"Aylesford",��"DSA",�"Prestedge"�"Bydell Hse"�"Sudbry Hill",�"Harrow",��"Acme Ltd",�"Meaden"�"Acme Rd",�"Acme Hill",�"London",��"Intera Ltd",�"Brice"�"Chiltern Hs",�"45 Stn Road",�"Henley",��"PPG",�"Jones"�"1 Pit Way",�"Murray Rd",�"Staines",��

CSV File Format



The first line in a CSV file is called the header line and this must always be present. . The header defines the field names of the CSV file. The following lines are individual contact records. Most database packages will provide a CSV format output of their data. Once you have a file in this format, you may import the data into OfficeTalk in the following way:



Firstly, select Import CSV Records from the File menu within Contact Mode.



�



Contact Mode menu



A CSV Import dialog box will appear:



�



CSV Import dialog box



Œ 	Select the CSV file containing the data that you wish to import. You can do this by pressing the � button and selecting the file from the File dialog box.



� 	Ensure that Contact is selected in the Import Type pull down list. Note that if you wish all the imported contacts to be visible only to you then select Personal Contact from the Import Type pull down list.



Ž 	The OfficeTalk Fields list will contain the available fields in a contact record. The Available Fields list will contain a list of fields found in the CSV file. You can connect the CSV file fields to OfficeTalk fields by selecting an item from each list and pressing the � button. The connection will appear in the Connections list at the bottom of the dialog box.



� 	If the CSV file has quoted fields (every field is enclosed by a pair of “” characters) then ensure that the Quoted Fields check box is checked. Sometimes fields are separated by TAB characters instead of commas. If this is true ensure that Tab is selected from the Delimiter pull down list.



(	Press the � button. OfficeTalk will begin importing the records. A Percentage window will appear informing you of the progress of the import. You can cancel the import at any time by pressing the Cancel button on the percentage window.



If a company/Contact group is currently selected, then the Import into current group check box will be enabled. If you check this box, OfficeTalk will import the data and will automatically put each record into the currently selected group.



C� XE "Connecting Contacts to Companies via a CSV Import" �onnecting Contacts to Companies via a CSV Import



If you have a CSV file which contains both company and contact information in the same record, then you should perform two imports; firstly import the company information, as described in Importing Companies from a CSV File above, and then, using the same CSV file, import the contact information, but ensuring that the [Company] field in the OfficeTalk Fields list is connected to the field representing the name of the company in the Available Fields list. OfficeTalk will then be able to associate all the contacts with the relevant companies.



E� XE "Exporting Contacts to a CSV file" �xporting Contacts to a CSV file



OfficeTalk lets you export contact records to a CSV file. This will export both company names and addresses. You can do this in the following way:

Œ	Firstly, select Contact CSV Records from the File/Export menu in Contact Mode. A CSV Output dialog box will appear.



�



CSV Output dialog box



�	Select a filename for the output CSV file. You can do this by pressing the � button and selecting the filename from the Save As dialog box.

	

Ž 	If you want each item of data to be encapsulated by quotes, then ensure that the Quoted Fields check box is select. If you want to output a header record at the top of the file then check the Output Header check box. If you want to end each record line with a delimiter (the default is not to) then check the End line with delimiter check box.



�	Choose a delimiter (field separator) by choosing a delimiter from the Delimiter field. You can choose between a TAB character and a COMMA.



(	Press OK. OfficeTalk will then export the records in the selected group (or all records in the database if no group is selected) to the specified CSV file.



C� XE "Creating a Company/Contact Group" �reating a Company/Contact Group



OfficeTalk lets you group together companies and contacts. You might want to group together your companies and contacts for several reasons. For example, if you wanted to create a mail merge file, or if you wanted to keep a list of prospects for a particular product.



A� XE "Adding/Editing/Deleting Groups" �dding/Editing/Deleting Groups



You can add, edit and delete groups by bringing up the Contact Groups dialog box. Do this by pressing the � button. The Select Contact Group dialog box will appear.



�



Select Contact Group dialog box



Next, press the � button. The Contact Groups dialog box will appear.



�



Contact Groups dialog box



A� XE "Adding a New Contact Group" �dding a New Contact Group



To add a new group, press the � button. A Contact Group dialog box will appear.



�



Contact Group dialog box



From this dialog box you can search for companies and contacts and add them to this group. You can do this in the following way:



Œ 	Enter a name for the group in the Name field.



� 	If the group is to be a private group then specify who the group will belong to by selecting the relevant name from the Owner pull down list. The default selection is --No Owner-- which means that all users will be able to see the group.



Ž 	Select the Companies radio button and then search for any specific company that you wish to add by typing in the first few letters of the company into the Search Text field and then pressing the � button. The results of the search will appear in the Results list. Alternatively, if you have previously performed a search using the Search Companies dialog box, you can press the � button. This will transfer the results from the Company Search dialog box to the Results list in this dialog box. Once you have some records in the Results list, you can add some or all of them to the group by selecting them and pressing the � button, one at a time.



� 	Select the Contacts radio button and search for contacts in a similar way to that described in Ž above.

E� XE "Editing a Contact Group" �diting a Contact Group



You can edit a group in the following way:



Œ Press the � button. The Select Contact Group dialog box will appear.



� 	Press the � button. The Contact Groups dialog box will appear. Select the group that you wish to edit and press the � button. The Contact Group dialog box will appear displaying the selected group. Edit the members and/or other attributes of the group and press OK.



D� XE "Deleting a Contact Group" �eleting a Contact Group



You can delete a group in the following way:



Œ 	Press the � button. The Select Contact Group dialog box will appear.



� 	Press the � button. The Contact Groups dialog box will appear. Select the group that you wish to delete and press the � button. 



OfficeTalk will confirm that you wish to delete the contact group.



�



OfficeTalk confirmation



S� XE "Selecting a Group" �electing a Group



Once you have created a group, you may select it in the following way:



Œ Press the � button. The Select Contact Group dialog box will appear.

� Choose the relevant group from the Contact Group pull down list and press OK.



� 



Select Contact Group dialog box



You can deselect a group by selecting --No Group-- from the Contact Group pull down list.



M� XE "Making a Group Default" �aking a Group Default



Once you have created a group, you may wish to make it the default group. This means that when you start up OfficeTalk and go into Contact Mode, this default group will automatically be selected. You can do this in the following way:



Œ 	Press the � button. The Select Contact Group dialog box will appear.



� 	Choose the relevant group from the Contact Group pull down list and press the � button. Then press OK.



You can instruct OfficeTalk to have no default group by selecting --No Group-- from the Contact Group pull down list and pressing the � button.





S� XE "Setting Up A Modem For OfficeTALK" �etting Up A Modem For OfficeTalk



OfficeTalk allows you to auto dial companies and contacts using a Hayes compatible modem. To set up a modem ready to auto-dial, connect it to a serial port that you have access to and bring up the Modem Settings dialog box by selecting Modem Settings from the Options menu in Contact Mode. 

�



Modem Settings dialog box



If you have a Hayes compatible modem, the settings in the Initialisation, Dial Prefix, Escape and Hang Up fields will already be set up for you. Ensure that the Port field selection corresponds to the port that you attached the modem to. 



Note:	If you need to specify a number to connect your internal telephone system to an outside line then specify this at the end of the dial prefix field.



When you press OK, OfficeTalk will remember your settings and you will be ready to use your modem for auto-dialling.

�Directory View    �� XE "Directory View" �



The Directory View lets you view contacts and companies in a telephone directory style. From this view you can go to a particular company or contact and you can add a company or contact to an existing group.



�



Directory View (Companies)





Viewing Companies� XE "Viewing Companies" �



You can view companies by pressing the � button. The name of the currently selected group, if any, will be shown at the top of the window along with the number of companies in the group. 





Viewing Contacts� XE "Viewing Contacts" �



You can view contacts by pressing the � button. The name of the currently selected group, if any, will be shown at the top of the window along with the number of contacts in the group. 





Selecting a Company/Contact Group� XE "Selecting a Company/Contact Group" �



OfficeTalk lets you select a company/contact group to view from the Directory View. See Selecting a Group above for more information.





Adding a Company or Contact to a Group� XE "Adding a Company or Contact to a Group" �



From Directory View you can add a company or contact to an existing group. For more information see Adding a Contact to a Group and Adding a Company to a Group above.





Viewing the Full Record� XE "Viewing the Full Record" �



You can view the full record for a company or contact from within Directory View by double clicking on the relevant record. The view will change to Company View or Contact View, as appropriate, and the record will be displayed.

�Conversation View    � � XE "Conversation View" �



Conversation View lets you record and view conversations you and other users have with contacts and companies defined in Contact Mode. In addition, you may add follow-up tasks, create conversation threads, filter and print conversations.



�



Conversation Read View



 



�



Conversation Write View



R� XE "Recording a Conversation" �ecording a Conversation



Conversation View comprises two sub-views; Read View and Write View. When you first enter Conversation mode, Read View is displayed. You can record a conversation in the following way:



Œ 	From within Contact or Company View, select the contact or company with which you wish to record the conversation. (Recording a conversation with a company rather than a contact is useful when it is not important who the contact was. For example, it might be the receptionist of a company explaining details of the company’s location.)



�  	From within Conversation View, press the � button. The contact and/or company selected will be shown in the Contact and Company fields. You can change the contact or company selected by pressing the � button next to either of the fields. In either case, a Company or Contact Search dialog box will appear as appropriate. Specify the first few letters of the contact or company that you wish to select and press the � button. Then select the company/contact and press the � button.



Ž	Enter a description of the conversation into the Subject field and then fill out the details of the conversation into the main window (the Conversation Window). You may attach one or more files to a conversation by selecting Attach Document from the Edit/Conversation menu or by double clicking in the Attach Window at the bottom of the view.. Any attached files will appear as icons in the Attach Window.



� 	To save the conversation, press the � button. The view will change back to Read View and the conversation will be saved. Your conversation will appear in the Conversations Window provided that it is not filtered out by the current conversation filter.





R� XE "Reading Existing Conversations" �eading Existing Conversations



To view conversations which have been previously recorded switch to Read View. In this view, conversations are listed in the Conversations Window. Each conversation is represented by a single entry in the Conversations window which displays the date and time of the conversation, which user recorded the conversation, with which contact the conversation was held, and what company that contact belonged to and the subject of the conversation.



�



Conversations Window



To view the body of a conversation, select the conversation entry by single clicking on the text line using the left mouse button. The body of the conversation will appear in the window underneath the Conversations Window.



� EMBED PBrush  ���



Conversation Window

The subject of the conversation is shown at the top of the window along with the thread number of this conversation (see Adding to a Conversation Thread later in this section).





E� XE "Editing Existing Conversations" �diting Existing Conversations



OfficeTalk lets you edit existing conversations. You can do this in the following way:



Œ 	Select the conversation that you wish to edit from the Conversations Window from within the Read View. Do this by clicking on the single line entry using the left mouse button.



�  	Provided that the conversation was originally recorded by you, the � button will become enabled. Press the � button. The view will be switched to Write View.



Ž	Modify the subject, and/or the conversation body, and/or the contact and company and any file attachments and then press the � button.





D� XE "Deleting Conversations" �eleting Conversations



You can delete conversations provided that you originally created them or you are a supervisor. To delete a conversation, do the following:



Œ 	Select the conversation that you wish to delete from the Conversations Window from within the Read View. Do this by single clicking on the single line entry using the left mouse button.



�  	Provided that the conversation was originally recorded by you or you are a supervisor, the � button will become enabled. Press the � button. OfficeTalk will confirm that you wish to delete the conversation. Press Yes. The conversation will now be deleted.



A� XE "Adding Follow-up Tasks to Conversations" �dding Follow-up Tasks to Conversations� XE "Follow-up Tasks" �� XE "Conversation Follow-Up" �



Often, as a result of a phone call or other conversation, you will need to action certain tasks. OfficeTalk lets you attach follow-up tasks to conversations. You can do this in the following way:



Œ 	Select the conversation that you wish to add a follow-up task to.



� 	Press the � button. A Follow Up Task dialog box will appear. Enter the description of the follow-up task in the Action field and enter a deadline by which the task should be complete in the Follow up by field. The task may be assigned either to yourself or to any OfficeTalk user visible to you. Users will be shown in the Assign To pull down list if you have creation access or higher to their diaries



�



Follow Up Task dialog box



When you press OK, OfficeTalk will create a task with the specified description in the assigned users task list (Diary Mode) and will link the conversation to the task. The link may only be seen by you. A �EMBED PBrush \s  \* mergeformat��� symbol will appear next to the conversation. Pressing the left mouse button down on the �EMBED PBrush \s  \* mergeformat��� symbol will show the link to the task. You can goto the task by selecting the link as described in Linking Information in the General OfficeTalk Features section. The task will also have a �EMBED PBrush \s  \* mergeformat��� symbol displayed next to it, allowing you to easily access the conversation to which it refers.



There is no limit on the number of follow up tasks which may be added to a conversation.





A� XE "Adding to a Conversation Thread" �dding to a Conversation Thread� XE "Thread" �� XE "Conversation Thread" �



If you wish to create a conversation which follows on from an existing conversation then OfficeTalk lets you join the conversations into a conversation thread. You can do this in the following way:



Œ 	Select the conversation that you wish to add to. Note that the conversation that you select must be either a non-threaded conversation (the title will read (1 of 1) ) or it must be the last conversation in the thread (the title will read (3 of 3), for example). You cannot join onto a conversation which is in the middle of a thread (for example if the title read (1 of 3) ).



� 	Press the � button. OfficeTalk will place you in Write View. The Subject, Contact and Company fields will already be filled out, however you may change any of them except the Subject field. 



Ž	Fill out the body of the conversation and press the � button. The new conversation will be linked to the selected conversation.



If you do change the subject of the conversation then OfficeTalk assumes that you do not wish to add the conversation to the thread after all. However OfficeTalk does warn you by popping up a Changed Subject dialog box. You are asked if you wish to create a new subject or associate with the old one.



�



Changed Subject dialog box



If you press the � button, OfficeTalk will not join the conversation to the thread, but will instead create a separate conversation with the new subject. If you press the � button, OfficeTalk will attach the conversation to the end of the thread but will change the subject back to the same subject used throughout the conversation thread.





F� XE "Following a Conversation Thread" �ollowing a Conversation Thread



Conversations which are threaded together are not usually consecutive entries in the Conversations Window. For this reason, OfficeTalk lets you move back and forward along any particular thread using the �EMBED PBrush \s  \* mergeformat��� and �EMBED PBrush \s  \* mergeformat��� buttons on the bottom Conversation Window. To do this, select a conversation which is part of a thread. If there is a conversation previous to the selected conversation in the thread, then the �EMBED PBrush \s  \* mergeformat��� button will be enabled. Pressing this button will take you to the previous conversation. If there is a conversation after the selected conversation in the thread then the �EMBED PBrush \s  \* mergeformat��� will be enabled. Pressing this button will take you to the next conversation in the thread.



C� XE "Conversation Filters" �onversation� XE "Filters" � Filters



OfficeTalk lets you filter conversations. This becomes essential when the number of conversations becomes quite large. OfficeTalk lets you filter on conversations held by a particular user, to a particular company or contact and over a particular date range.





A� XE "Adding/Editing/Deleting Conversation Filters" �dding/Editing/Deleting Conversation Filters



You can add, edit and delete filters by bringing up the Conversation Filters dialog box. Do this by pressing the � button. The Select Conversation Filter dialog box will appear.



�



Select Conversation Filter dialog box



Next, press the � button. The Conversation Filters dialog box will appear.



�



Conversation Filters dialog box





A� XE "Adding a New Conversation Filter" �dding a New Conversation Filter



To add a new filter, press the � button. A Conversation Filter dialog box will appear.



�



Conversation Filter dialog box



From this dialog box you can select:

		

Œ 	--All Users-- or a particular user.



� 	--All Contacts-- or a particular contact or --Current Contact--. If you select --Current Contact-- then OfficeTalk will show only conversations had with the contact currently displayed in the Contact View within Contact Mode.



Ž 	--All Companies-- or a particular company or --Current Company--. If you select --Current Company-- then OfficeTalk will show only conversations had with the company currently displayed in the Company View within Contact Mode.



� 	A date range. If you select the Date Range check box, a From and To field will appear. If the To field is left blank then OfficeTalk will treat this as the future date.





E� XE "Editing a Conversation Filter" �diting a Conversation Filter



You can edit a filter in the following way:



Œ 	Press the � button. The Select Conversation Filter dialog box will appear.



� 	Press the � button. The Conversation Filters dialog box will appear. Select the filter that you wish to edit and press the � button. The Conversation Filter dialog box will appear displaying the attributes of the selected filter. Edit the attributes of the filter and press OK.





D� XE "Deleting a Conversation Filter" �eleting a Conversation Filter



You can delete a filter in the following way:



Œ 	Press the � button. The Select Conversation Filter dialog box will appear.

� 	Press the � button. The Conversation Filters dialog box will appear. Select the filter that you wish to delete and press the � button. 





S� XE "Selecting a Conversation Filter" �electing a Conversation Filter



Once you have created a filter, you may select it in the following way:



Œ Press the � button. The Select Conversation Filter dialog box will appear.

� Choose the relevant filter from the Conversation pull down list and press OK.



� 



Select Conversation Filter dialog box



You can deselect a filter by selecting --No Filter-- from the Conversation pull down list.



M� XE "Making a Conversation Filter Default" �aking a Conversation Filter Default



Once you have created a filter, you may wish to make it the default filter. This means that when you start up OfficeTalk and go into Conversation View, this default filter will automatically be selected. You can do this in the following way:



Œ 	Press the � button. The Select Conversation Filter dialog box will appear.



� 	Choose the relevant filter from the Conversation pull down list and press the � button. Then press OK.



You can instruct OfficeTalk to have no default filter by selecting --No Filter-- from the Conversation pull down list and pressing the � button.





S� XE "Searching Conversations" �earching Conversations



OfficeTalk lets you search through conversations for any text. You can do this by pressing the �EMBED PBrush \s  \* mergeformat��� button which is above the Conversation Window. When you press this button, the Search Conversations dialog box will appear.

�



Search Conversations dialog box



The Search Conversations dialog box consists of a Search field into which you may enter your search text, a � button for performing the search and a � button for displaying the resulting record. There is a Users list from which you may choose to search conversations of either --All Users-- or one or more specific users. A Date Range check box lets you specify a date range over which to search for conversations. Radio buttons let you choose between searching Subject Text only or All Text. The search may be performed on either all conversations (Database), Filtered Conversations, or the Search Results. 



You can search for conversations in the following way:



Œ Enter some search text into the Search field.



�	Select either the Subjects Only radio button which will search only the subject text of conversations or the All Text radio button to search the body of the conversation as well as the subject text.



Ž Press the � button.



The results of the search will appear in the Results window at the bottom of the Conversation Search dialog box. You can display any of the conversations in the Results window by selecting the relevant conversation and pressing the � button. OfficeTalk will close the dialog box and load the record into the Conversation Window.



L� XE "Linking Conversations to other OfficeTALK data" �inking Conversations to other OfficeTalk data



OfficeTalk lets you link conversations to other OfficeTalk data. You can do this in the following way:



Œ 	Select the conversation that you wish to link in the Conversations Window.

� 	Press the � button above the Conversations Window.

Ž 	Select another linkable item and press the � button above that item’s window.



The conversation will now be linked to that item. A �EMBED PBrush \s  \* mergeformat��� symbol will appear in the Conversations Window. For more information on linking, see the Linking section in the chapter named General OfficeTalk Features.



P� XE "Printing Conversations" �rinting Conversations



OfficeTalk lets you print out conversations by pressing the � button above the Conversations Window. When you press this button, the Print Conversations dialog box will appear.



�



Print Conversations dialog box

The fields and buttons in the Print Conversations dialog are described in the table below:



Field/Button�Description��All in current filter/ All in current thread�You may choose what to print by selecting one of these radio buttons. You can print either all the conversations in the filter (all conversations will be printed if no filter is selected) or you can print all conversations in the current filter.��New page per Conversation�Check this check box if you wish to start a new page for every conversation.��Line between conversations�Check this check box if you wish to print a horizontal line between each record printed.��Display field names�Check this check box if you wish to print the title for each field, i.e. "Date", "Time", "Contact", "Company", etc.��Print Fields�Select which fields you wish to print from this array of check boxes. You can choose from Date, Time, User, Company.��Paper�This is the paper style that OfficeTalk will use to print. For more information on paper styles, see the Printing section in the General OfficeTalk Features chapter.��Field Name Font�The font of the field names. This is only relevant if the Display field names check box is checked.��Field Font�The font of the fields.��Subject Font�The font of the subject description.��Text Font�The font of the conversation description.��

OfficeTalk provides common print functionality in all Print dialog boxes. This functionality includes:



	�SYMBOL 183 \f "Symbol" \s 12 \h�  Defining headers and footers

	�SYMBOL 183 \f "Symbol" \s 12 \h�  Printer setup

	�SYMBOL 183 \f "Symbol" \s 12 \h�  Preview capability



For more information on this common print functionality, see the Printing section in the General OfficeTalk Features chapter.�
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